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READ THIS FIRST

SINGLE END-USER LICENSEAGREEMENT FOR Remote Monitoring System
(RMS) SOFTWARE (“RMS Software’)

IMPORTANT-READ CAREFULLY. This End-User License Agreement is alicense agreement between you and Meyer
Sound L aboratories Incorporated for the Remote Monitoring System Software Product, which includes computer
software, associated media, and printed materials. By installing, copying, or otherwise using thisRM S Software, you
agree to be bound by the terms of this agreement. If you do not agree to the terms of this agreement, then DO NOT install
or usethe RMS Software.

IFYOU DO NOT AGREE TO THE TERM OF THISAGREEMENT. If you do not accept this license agreement and
your RM'S Software is delivered with a preconfigured computer or host station purchased from Meyer Sound, do not use
your preconfigured computer or host station, and promptly return it, undamaged, initsoriginal packaging, to Meyer
Sound Laboratories Inc. (“Meyer Sound”) for afull refund. If your RMS Software has been shipped to you for use on a
computer or host station purchased from another entity or as a replacement for software you are currently using, immedi-
ately return the RM S Software to Meyer Sound together with any peripheral items delivered and packaged with the
software, and any license fee or other charges paid by you in connection with the delivery of the RMS Software or such
peripheral items shall be refunded. Please note that your right to receive any replacement of existing RMS Softwareis
conditioned on your acceptance of the terms and conditions of this agreement.

SOFTWARE PRODUCT LICENSE

This program is confidential and the proprietary property of Meyer Sound. It isfurnished under arestrictive license and
may be used and reproduced only in accordance with the terms of thislicense agreement. This program and any copies of
it may only be provided or otherwise made available to persons licensed by Meyer Sound Laboratories Incorporated to
use the program.

Thislicense grants you, the registered user, the following rights:

-The RM S Software product is provided to you in machine-readable form. You may not reverse engineer, decompile,
disassemble or otherwise create a human-readable version of the RM S Software, or any portion thereof, nor shall you
permit othersto do so.

- The RM S Software may be installed and used on only a single computer, or host station. The RM S Software may not be
shared or used concurrently or otherwise on different computers.

- Limited Warranty. Meyer Sound warrants, for a period of ninety (90) days from the date you receive your RMS
Software, that such software, when properly installed, will perform substantially in accordance with Meyer Sound’s
current published documentation for the RM S Software. Meyer Sound does not warrant that the functions contained in
the RM S Software or any replacement copy will meet your requirements or that the operation of the RM S Software or
any replacement copy will be uninterrupted or error free. Meyer Sound’s sole obligation under this warranty isto
exerciseits best efforts to remedy any defect in your replacement copy of the RM S Software in amanner consistent with
Meyer Sound’s customary business practices.



WARRANTY LIMITATIONS; LIMITATIONS OF REMEDIES. THEABOVE LIMITED WARRANTY ISTHE ONLY
WARRANTY MADE BY MEYER SOUND IN CONNECTION WITH YOUR RMS SOFTWARE. THERE ARE NO
OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TOANY WARRANTIES OF
MERCHANTABILITY OR FITNESS FORA PARTICULAR PURPOSE. MEYER SOUND’SENTIRE LIABILITY
AND YOUR EXCLUSIVE REMEDY ARISING OUT OF OR IN ANY CONNECTED WITH THISAGREEMENT
AND/OR YOUR USE OF THE RMS SOFTWARE, REGARDLESS OF THE CAUSE OR FORM OF ACTION, SHALL
NOT EXCEED THEAMOUNTS PAID OR PAYABLE BY YOU FOR THE PURCHASE OF RMS SOFTWARE. IN
NO EVENT SHALL MEYER SOUND BELIABLETOYOU ORTOANY THIRD PARTY FORANY CONSEQUEN-
TIAL, INCIDENTAL, OR SPECIAL DAMAGES (INCLUDING LOST PROFITS) ARISING OUT OF OR IN ANY
CONNECTED WITH THISAGREEMENT OR Y OUR USE OF THE RMS SOFTWARE, REGARDLESS OF LEGAL
THEORY, AND EVEN IF MEYER SOUND HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

- A single back-up copy of your RMS Software may be produced from the original source media. Such back-up copies
shall be subject to the terms and conditions of this agreement, except Meyer Sound shall not warrant the reliability of
such Back-up copy.

- You may permanently transfer all of your rights under this agreement, provided you (@) retain no copies, (b) transfer all
of the RM S Software Product, any upgrades, this license agreement and all supporting documentation, and (c) the
recipient agrees to abide by all of the terms and conditions of this agreement.

- Meyer Sound L aboratories may terminate this license agreement if you or your successors or assigns fail to comply with
the terms and conditions of this agreement. To this end, you grant Meyer Sound Laboratories the right to verify your
implementation, use and duplication of the RM S Software.

- General. Thisagreement and performance hereunder shall be governed by and construed in accordance with the laws of
the State of CaliforniaU.S.A. If any provision of thisagreement is held invalid by a court of competent jurisdiction, such
provisionisto that extent to be deemed omitted. Any suit brought by either party against the other on the basis of any
controversy or claim arising out of or relating to this agreement or the breach thereof, shall be brought in the appropriate
court in the State of California, and you hereby submit to the personal jurisdiction of such court.

Please read and observe all third-part software license agreements included in this RM S package.

RMSisatrademark of Meyer Sound Laboratories.

Copyright 1995-2000 Meyer Sound L aboratories, Incorporated. All rightsreserved.
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Description and Overview of RMS

Related Documentation

For background information on RMS please review the
RMS Q&A(M.S.P/N01.033.072.01 A),

RMS Data-sheet(M.S.P/N04.033.073.01 A),
Self-Powered Loudspeaker Installation & Wiring Guide
(M.S.P/N05.033.075.07Rev 3.5),

RMS License Agreement
(M.S.P/N05.033.075.10Rev.3.5)

RMS™ Host Computer Requirements List
(M.S.P/N05.033.075.13Rev3.5)

Host Computer Software Installation
(M.S.P/N05.033.075.02Rev.3.5)

The Software Package:

Included in this release is:

- Echelon LonManager Dynamic Data
Exchange (DDE) server.

- Echelon LonMaker Network Manager

- Remote Monitoring System Program and
Database for Windows 95/98

What is RMS?

Remote Monitoring System displays critical op-
eration data from Meyer Self-Powered Loud-
speakers in a graphical Windows program. The
speaker data is transported across an Echelon
LonWorks based twisted pair network.

The host program displays input and output volt-
ages, polarity information, amplifier power and
limiting information, driver conditions, as well as
the amplifier temperature and fan speeds of each
self-powered RMS speaker in the network system.
Inaddition, RMS can be configured to mute or solo
speakers, makingita perfecttool for system engi-
neers and sound mixers.

How many Meyer Self-Powered Loudspeak-
ers can be connected to an RMS Network?

RMS version 3.5 for Windows 95/98 can monitor
up to 125 speakers on a single channel network.
However, systems with more than 62 speakers or
more than 1500 feet of cable require arepeater, a
hardware device available from Meyer Sound. A
single repeater will allow up to three branches of
1500° and 62 speakers each, provided the total
number of speakers does not exceed 125.
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Formore information on wiring please referto the
RMS Self-Powered Loudspeaker Installation
and Wiring Guide (M.S. P/N. 05.033.075.07
Rev. 3.5). For more information on a repeater
contact Meyer Sound Technical Support.

RMS Systems can be configured using routers to
increase capacity up to 230 speakers on multi-
channel systems. Routers can also be used to
transmit network data across Ethernet lines. For
information onthese advanced capabilities contact
Meyer Sound Technical Support.

Whathardwareis required to run RMS?

While RMS will run on desktop or portable Win-
dows 95/98 systems with any pentium processor,
we strongly recommend a Pentium system witha
minimum CPU speed 0f266 MHz and atleast 32
MB of memory. A screen resolutionof1024x768
pixelsis highly recommended for systems witha
large number of speakers, however, 800x600 pix-
elsissufficient. Formore information consultthe
Meyer Sound document RMS Host Computer
Requirements List (M.S. P/N 05.033.075.13
Rev 3.5).

Can I run other programs on my RMS host
computer?

RMS consists ofaseries of complex hardware and
software interactions. Installing orusing other hard-
ware or software on an RMS host computer may
resultinmemory warnings and increased latencies.
Werecommend running RMS on adedicated
host computer free from other applications.



RMS Software and Hardware Interaction )

When approaching RMS for the first time, it is useful to have a general understanding of how the different
software and hardware components of a host computer and RMS system interact. Pictured belowisa
diagram which depicts these interactions.

Network (Twisted Pair Cable) To other cabinets

L

Meyer RMS

Host Program
(For Windows) PCLTA-10 Card o
Half Length ISA Board Communications Board
(For Desktops) ( Meyer )

or

PCC-10 PC Card
(for Laptops)

Echelon
DDE Server
(Windows)

(Echelon)

Amplifier Circuitry
( Meyer )

RMS Database
(on hard drive)
( Meyer)

Echelon LonMaker
Installation Program
(DOS mode in
windows)

RMS Self-Powered Loudspeaker

RMS Host Computer

Key:

Q Software

Hardware

Neuron Chip (made by Echelon)

(Echelon)  Echelon Product

(Meyer)  Meyer Sound Product




Running the RMS Program

Starting RMS

There are several ways to start RMS in Windows. If you successfully completed the Host computer
installation, or received a preconfigured host computer from Meyer Sound, RMS should begin on start up
when the computer is powered on. Otherwise, double click the RMS icon on the desktop or open the

RMS program in the Meyer Sound Laboratories folder.

Whenyoustart RMS forthe firsttime, an untitled panel and page will be displayed,as shown below:
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Ifyour RMS system was installed and configured at the factory, a panel will have already been set up for
you. Youwill see the panel load and loudspeakericons displayed on the page. RMS remembers the last
panel that was opened and reloads that panel the next time it is started.

The Menu Bar
There are five pull-down menus on the menu bar (just below the program title). These five menus control
most of the major functions of RMS. They are: Panel, Add, View, Options, and Help.

Panels and Pages

A panel consists of one to twenty pages of icons and other views of loudspeaker information. Each page
can contain a single speaker or a group of speakers. Panels can be saved and loaded to and from your
harddrive. Panels allowyouto create as many different speaker-system configurations as you like.

The multi-page interface is controlled with tabs. The tabs are used to select a page to be displayed or to
add loudspeakers to. The tabs also display the page name and status for that page. See the Multi-Page
Interface sectiononpage 1-11 for more information on panel pages (adding, deleting, renaming, etc).

The Panel Menu

When you select Panel in the menu bar, or hold down the Alt key and press P, the Panel pull-down menu
will appear. This menu consists of the following options:

New... Creates anew panel.

Open... Opensan existing panel.

Save Saves the panel currently open under its original name.

Save As... Savesthe currently open panel under a different name.

AddPage... Adds anew page to the current panel.

Delete Page... Deletes the currently displayed page from a panel.

Rename Page... Renames the currently displayed page on a panel.

Exit Quits the RMS and prompts the user to save any changes made to the open panel.

1-6



Adding Loudspeakers to a panel

Before loudspeakers can be monitored they must be installed on the network as described in the RMS
Self-Powered Loudspeaker Installation and Wiring Guide contained in your RMS documentation. If
your RMS system was installed and configured at the factory, the loudspeaker installation step will have
already been done foryou.

When adding speakers to a panel you will need to refer to the list of network installed speakers, serial
numbers, and device names you created during loudspeaker installation. Refer to the end of this guide,
page 1-27 for a sample RMS Configuration Data Sheet.

Monitoring begins immediately once aloudspeakerisadded to the panel as long asithas been installed on
the network and is physically connected to the network interface card in the host computer by a twisted
pair wire.

The Add menu allows you to add loudspeakers to your panel. When you select Add in the menu bar you
will see alistofall of the loudspeakers supported by RMS.

Add Speaker Dialog

To add aloudspeaker to the panel, first select Add in the menu bar then click-on the type of loudspeaker
youwishtoadd. Thiswill launch the Add Speaker Dialog pictured below:

Add speaker E |

Enter the device name  Used Device Names
. : I— aszigned to this speaker spk 1 -
Device Name: [EHRIE when it was installed uzing spki02
the Lot aker Metwork:
b anagement Frogra.

Speaker Title: IMSL-4 H#3 Enter up ta 12 characters for

a speaker fitle,

Cancel |

In the Device Name field enter the unique name that was assigned to this loudspeaker when it was installed
onthe network using the LonMaker program. The Device Name field will be primed with the last device
name that was entered with anincremental ending number (ifthe device name ends with anumber).

Inthe Speaker Title field enter a title name for the loudspeaker. The Speaker Title field will be primed with
aname based on the type of loudspeaker you selected from the Add menu with an appended number
representing the count ofthat type of loudspeaker on the current panel.

The Used Device Names list shows all of the device names that have been added to the current panel.



Adding Loudspeakers to a panel

Youmay enter any name in the Title Name field provided itis 12 letters or less in length and contains only
letters, numbers, spaces and dashes. Youmay use descriptive names. Forexample, ifyouare adding an
MTS-4 thatyou planto use for side-fill on the left side of the stage, you might use the title ‘MTSLftFill1".

When you have entered the device name and title, select the OK button to add the speaker to the panel.
This will clear the dialog and place the new loudspeaker on the current page of the panel.

When you have multiple pages defined for a panel, new loudspeakers will be added to the currently
selected page as shown by the tabs at the top of the page.

Adding Meter and Text Views

To open ameter view of the speaker, double click the speakericon. To open atext view of the speaker,
doubleclick theiconagain. For more information on changing loudspeaker views see Switching Between
Display Views later in this guide.

Renaming a Panel Page

To rename the current page that you have just added a loudspeaker to, click on Panel on the menu bar
and then select Rename Page. A dialog will be presented for you to enter a name for the page. You can
enter any name up to 10 characters in length.

Saving Your Panel

Now that you have added a speaker to the panel and renamed the page, save your panel by clicking on
Panel on the menu bar and then selecting Save. You will be asked to choose a directory and name for
your panel. We strongly suggest you use the c:\tnode directory, which will be selected by default. Make
sure youremember where you put your panel and what you named it so that you canrecall itlater on. After
saving, the name of your panel will appear at the top of the screen next to the RMS title. Unsaved panels
that have had changes made to them will be depicted with an asterisk appended to the name on the
window title bar.

Atthis point, ifthe speaker is hooked up and properly configured, the icon’s online indicator will be green.
Youare nowmonitoring the speaker. Ifthe speaker isnotattached to the network then the online indica-
torwill bered. The window on the next page displays anicon fora MSL-4. Ifyouinstalled another
speaker type you will see adifferenticon.

Samplelcon Views

1-8



Adding Loudspeakers to a Panel
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The Status Bar

The RMS Status bar is displayed at the bottom of the main window. Youcantoggle the Status Baron
and off by clicking Options and then clicking Status Bar.

The number at the far left of the status bar indicates input polarity of all speakers on the panel. Ifall of
your input polarity switches are set to pin 2 hot, then 2+ will appear here. Ifall of your input polarity
switches are set to pin 3 hot then 3+ will appear instead. Panels that contain pin 2 and pin 3 hot speakers
will display 2+3+onthe menu bar.

Theright side of the status bar shows the number of loudspeakers that are online and communicating with
the host program and the total number of loudspeakers on the panel. The middle ofthe status bar shows
the selected muting options.

Deleting Loudspeakers

Toremove aloudspeaker from a panel, place the mouse cursor over the loudspeaker you wish to remove
and then press the right mouse button. A menu will appear over the loudspeaker. Select Delete from this
menu and confirmation dialog will appear. To delete the selected loudspeaker select OK, to returnto the
panel without deleting select No.

Renaming a Loudspeaker

Torename a loudspeaker, place the mouse cursor over the loudspeaker you want to rename and press the
right mouse button. Select Rename from the menu and arename dialog will appear. Enter anew name
for the loudspeaker and then select OK, or select Cancel to return to the panel without renaming the
loudspeaker.



Panel Functions

Opening an Existing Panel (Ctrl+O)

Choose Open from the Panel menu (Panel>Open) to load an existing panel file into the RMS display. If
you have made changes to your panel since you last saved it you will be asked if you want to save your
panel. If you want to keep your changes select Yes, if you want to discard your changes select No.

Afterthe Open file selector dialog is launched, select the file name of the panel that you wish to load.
Select OK or press <Enter> to load the file. This will reload the last saved version of the panel. Click
Cancel or press the Esc key to cancel the file load and return to the existing panel.

Note: Ifyou have made changes to a panel and want to restore the panel to it’s original state you can use
the Open panel function to do so. Enter No when you are asked to save changes to the loaded panel and
then reload the panel by selected it in the Open file selector dialog box.

Starting a New Panel (Ctrl+N)

Choose New from the Panel menu (Panel>New) to start a new panel. If you have made changes to your
panel since you last saved it you will be asked if you want to save your panel. If you wantto keep your
changesselect Yes, if you want to discard your changes select No.

Saving a Panel to a New File

Choose Save As from the Panel menu (Panel>Save As) to save the currently loaded panel to a new file.
Afterthe Save Asfile selector dialog is launched, select a folder to store the new file in and type inanew
name. Select OK or press <Enter> to save the panel in the new file. Click Cancel or press the Esc key to
cancel the file Save As and return to the existing panel. After yousave the panel to the new file the new
name will be displayed on the title bar of the RMS main screen. Ifyou selecta file thatalready exists you
will be asked if you want to replaceit. Click Yes to replace the existing file. Click Noto cancel the save
and return to the file selector dialog

The View Menu

When you select View in the menu bar, or hold down the Alt key and press V, the View pull-down menu
will appear. Select the option for the initial view that you want to appear when you add aloudspeaker to
the panel. This menu consists of the following options:

Small Icons when a speakerisadded it will appear as a small icon.
Icons when a speaker is added it will appear as an icon.
Meters when a speaker is added it will appear as a meter view.
Text when a speaker is added it will appear as a text view

Note: This setting does not affect speakers already on the panel. It only affects the initial view of loud-
speakers added after the setting is changed. The default for this setting is Icon view.
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Multi-Page Interface

The Multi-Page Interface isnew for Version 3.5 of RMS. A panel setup can now span across multiple
pages. Upto 20 pages can be added to a panel setup. The new interface uses a tab control at the top of
the page to select which page to display. The name of the page as well as page level status of all of the
speakers on that page are displayed on the tabs. The tabs also indicate the number of loudspeakers on
the page as well as the number that are currently online.

Number of loudspeakers
Online and on the page

1) Remote Monitoring System - Three2*
Lanel Add Yiew Option: Help

/ Stage 1-1 | (1) Left 0-1 Right 0-1
Page Level Status

Page Name

Page Level Loudspeaker Status

The status for all of the loudspeakers on a page is propagated to the tab for that page. Ifany loudspeaker
islimiting oris displaying a warning icon, that status will be displayed on the tab for that page. A green

circle onthetabindicatesall the loudspeakers on that page are online and functioning correctly.

Navigating Through Pages on a Panel

There are several ways to navigate through the pages on a panel. Click on the tab for a page to select the
page for display or use the keyboard as described below:

tab key Pressing the tab key will scroll through each of the pagesin order. Holding the shift
key and pressing the tab key will scroll through the pages in reverse order.

Numeral Keys Pressing the numeral keys will select pages 1to 10 (leftto right).

1,2,3..0



Multi-Page Interface

Add a Page (Ctrl+A)

Choose Add Page from the Panel menu (Panel>Add Page) to add a new page to the current panel. Type
in aname for the new page in the Enter Page Name dialog. The name may be up to 10 characters in
length. Select OK or press <Enter> to create the new page. This will add a blank page to the panel.
Click Cancel or press the Esc key to cancel the Add Page and return to the last page displayed. To add
loudspeakers to the new page select a speaker type from the Add menu and proceed as described in the
Adding Loudspeakers to a Panel section.

Delete a Page (Ctrl+D)

Choose Delete Page from the Panel menu (Panel>Delete Page) to delete the currently displayed page. A
dialog will be presented asking you to confirm the delete operation. Select OK to delete the current page.
Click Cancel or press the Esc key to cancel the delete operation.

Important! All of the loudspeakers on the current page will be deleted also! The delete opera-
tion cannot be reversed! Although, if the panel has not been saved since a Delete Page opera-
tion, the page can be restored by reloading the panel using the (Panel>Open) menu function and
selecting No when prompted to Save changes to the panel. Then, selecting the last saved copy of
the panel will restore the panel from that point.

Rename a Page (Ctrl+R)

Choose Rename Page from the Panel menu (Panel>Rename Page) to rename the currently displayed
page. Type in a name for the new page in the Enter Page Name dialog. The name may be upto 10
characters in length. Select OK or press <Enter>to rename the new page. The new name will be dis-
played on the tab for that page. Click Cancel or press the Esc key to cancel the Rename Page.



Loudspeaker Views

Switching Between Display Views

Each loudspeaker on a panel can show up to 4 different views of loudspeaker data.

The Loudspeaker Properties menu

Place the mouse cursor over one of the speaker icons and press the right mouse button. A properties
menu will appear with six options: Small Icon, Icon, Meter, Text, Rename, and Delete. Clicking on Rename will
allowyouto change the title of the selected loudspeaker. Clicking on Delete will remove the loudspeaker
fromthe panel.

Nextto the word Icon is acheck mark. This check indicates the currently displayed style. Select the Meter
option. A meter view will appear and the menu will disappear. Right click the meter view and then select
Text from the menu. A textview will appear displaying numeric information for the selected loudspeaker.
Right click onthe text view and select Smalllcon from the menu. A small icon will appear in the window.

Rightclicking on any of the display styles will bring up the properties menu. Double clicking onthe Icon
view with the left mouse button will bring up the Meter view. Double clicking on the Meter view will bring
up the Text view. To bring up all three displays quickly you cantriple click on a speakericon.

Atthispointyou should see all of these display styles on your panel:

lcon View Meter View Text View
=
MEL4#] (5 & MSL-4 #1 i— * Jspk01 MSL-4 #1 |
'.'
t_ high "m I II —high Temperature
inpu _w
- ZE_I-u lim tmpfans input [ Eowpk [ 260 wpk| amp| 35 C
[=1%] -
v Smalleon Iﬁ ok | 47 Wave (0 % Lirnit
o Loy : I— o Fan zpeed
o
v %Et‘:’ pin2 [E3vpk [ 260 wpk| primay | 47 %
v
Small lcon View L I—22 S WDC I 47 Wave 0 % Limit| reserve |of £
Bename... urregulated
Delete... sLpply | IDn line
Properties Menu =] L= o) I
(right click on any view) | iie | solo | wink | | close |
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Loudspeaker Views

The Icon View
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TheIcon Display

Icon View Reference

Speaker Title The name you assigned to the speaker.

Amplifier Channel Status Theamplifier channel corresponding to the driver pictured on the Icon.
The color codesare as follows:

Green: Amplifiervoltage present.

Gray: Noamplifier voltage present.

Red: Channellimiting,

Yellow: Voltage present without power: Opendriver circuit.
Orange: ExcursionIndication

Mute Buttonand Indicator Clicking on this button will mute the speaker provided you have
enabled muting. (Green=unmuted, Red=muted).

Solo Button and Indicator Whenmutingisenabled, clicking on this button will unmute the loud-
speaker and mute all other speakers. The indicator will be yellow
when the speaker has been selected for solo operation.

Wink Button and Indicator Clicking on the wink button will lighta green LED labeled “Wink™ on

the RMS user panel of the loudspeaker. This can be used to identify
the loudspeaker corresponding to the icon on the screen. The
indicator will show green when wink is enabled.



Loudspeaker Views

InformationIndicator [T} SpeakerIcons will display ayellow warning indicator ifany of the
following conditions are met:

Amplifier Heat Sink >70 degrees C.

No Primary Fan Current.

Primary Fan Current>97%.

Reserve Fan On.

Driver Open Circuit.

Driver Short Circuit.

Loudspeaker Offline (including speakers not powered on).

Speaker Communication Greenindicates that the loudspeakeris online. Red indicates thatthe
hostcomputerisnotreceiving information from the loudspeaker.

The Small Icon View

The smallicon view is similar to the standard icon view, except that itis smaller and does not reflect the
physical properties of the loudspeaker. All ofthe loudspeakers have the sameicon forthis view.

Mute, Solo, and

Wink Butt .
He BULONS msid #1| €<— Speaker Title
" Drivers
Speaker Communication Information Indicator

Formore information on the small icon view display, refer to the reference for The Icon View.
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Loudspeaker Views

The Meter View

Close Eiuttun Title Limiting Frifnary Fan Speed

Resewe Fan Speed

Criver Diameter MSL 4
Input Signal Level b P—— i
inpu
SpeakerCDmmunicati - 2 trni:'ians
[nput Polarity Switch F'I:usmu \Heat Sink Temperature

Armplifier Power Armplifier Voltage

Meter View Reference

Close Button Clicking onthis button will close the Meter view.

Input Signal Level Thismeter bar displays the peak voltage of the input signal. Thisbar
iscolor coded for these conditions:

Green -inputsignalisbelow 8 volts peak.
Yellow -inputsignal is between 8 and 9 volts peak.
Red -inputsignalisabove 9 voltspeak.

Speaker Communication Indicates whether or not the loudspeaker is communicating with the
hostcomputer (Green=online, Red = offline).
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Loudspeaker Views

Input Polarity Switch Position This display shows ifthe signal input XLLR connectoris setto pin2 or
pin3 hot.

Primary Fan Speed Thisdisplays the amount of current sent to the primary cooling fan.

Reserve Fan Active This baris yellow when the Reserve fanison.

Limiting These displays show limiting activity on theirrespective amplifier

channels. These displays also depict excursion on most subwoofers.

Speaker Title Thetitle of the speaker.

Driver Diameter This shows the diameter of the driver being driven by each amplifier
channel.

Amplifier Voltage Indicates peak and average voltage ofthe amplifier.

Amplifier Power Indicates the peak power produced by the amplifier.

Heat Sink Temperature Indicates the temperature of the amplifier heat sink in degrees
centigrade.
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Loudspeaker Views

The Text View

Two Channel Text View for the Concert Series speakers:

Peak*oltage

Average Yoltage

T~

Input vWoltage —— 3

Input Polarity
Switch Position

D Supphy »
Headroom

Mode Mame

Title

v

vnodel1 M5SL-4

Feak Power

high

| 42/ Wpk | 193 l'v?{’
I.l . 2| Mpk I 8 Wave 0 = Limnit
Ik
pinﬁ + Iy

I 20 vpk I 47 'wpk

Iﬂvm: I B W ave 0 % Limit| "==="® of £/
unregulated
sLpply Hlonline %
I—'{——
L i L

emperature

IE?E{—

Fan speed

Percent Limiting

 %|[€— Close Button

oindoves 95 onlyd

Heat Sink Temperature

prirmany | 41 % #— Primary Fan Speed

Reserre Fan

Speaker Communication
Service Pin Indicator

mutt:l solo | wink |

Fault Indicatar

-«
close |T7 Close Buttan

Text View Reference

Close Button

Amp Heat Sink Temperature

Primary Fan Speed

Reserve Fan

Speaker Communication

Service Pin Indicator

Mute, Solo, and Wink Buttons

Clicking on this button will close this text view.

Displays the temperature of the heat sink in degrees centigrade.

Displays the speed of the primary fan as a percent of the fan’s

maximum speed.

This field shows the status of the reserve fan.

Displays online or off-line depending on speaker communication with
the host computer (Green = online, Red = offline).

When the service pin on the back of the amplifier user panel is pressed
this field will display “service pin” and a cartoon face will be displayed
on each loudspeaker view.



Loudspeaker Views

Fault Display

Wink Button

Mute Button

Solo Button

DC Supply Status

Input Polarity Switch Position

Input Signal Level

Speaker Device Name

Amp Channel Information

Peak Voltage (Vpk)
Average Voltage (Vave)
Peak Power (Wpk)
Limiting (% Limit)
Excursion

Attenuation

This field will alert you to faults such as shorted drivers.

Clicking on the Wink button will light a green LED labeled “Wink™ on
the RMS user panel of the loudspeaker. This can be used to identify
the loudspeaker corresponding to this view.

Clicking on this button will mute the speaker provided muting is
enabled.

When muting is enabled (see page 20) clicking on this button will
unmute this speaker and mute all other speakers. The button indicator
will be yellow when the speaker has been selected for solo operation.

This number should be over 17 VDC if the AC main voltage is suffi-
cient.

This display indicates if the signal input XLLR connector is set to pin 2
or pin 3 hot.

This field displays the peak voltage of the input signal.

The device name that the loudspeaker is using to communicate with
the host computer.

Displays the following information for their respective amplifier
channels: Peak Voltage, Peak Power, Average Voltage, Percent
limiting.

Displays the peak voltage of the amplifier.
Displays the average voltage of the amplifier.
Displays the peak power of the amplifier.
Displays percent limiting.

Displays percent of total excursion.

For Ultra-series speakers equipped with the optional attenuation input
module this field displays attenuation in dB.



Loudspeaker Views

Differences Between Loudspeaker Models

There are afew differences in the loudspeaker data and views for some models. The following two pages
highlightthesedifferences.

The Self-Powered Ultra Series Loudspeakers:

The differences between the Concertand Ultra series views are shown in the following illustrations:

{1y nodell uwpal #1 |
Aﬂfenuatl_on]?ata attnD . —high Temperature
(with oppona —F. t [ Owpk | Owpk amp] OC
- n irpL s
?Ite uatio Iﬁ ok I 0| Wave 0 & Limit .
input module) Dptional
ol —lowy Fan zpeed Fan Speed
P [ Owpk | 0wk [ 0z Data for
Im VDO | 0| Wave I 0 & Limit speakers
unregulated 1
supply || IOFFI.INE equ pped
E— withan
o = = optional
mute | solo | wink I I ﬁl cooling fan.

The UPM-1P and UMS-1P also optionally display attenuation, but do not display fan speed or unregu-
lated supply voltage.

) spk02 UPM-1P =)

Iﬂ —high Temperature
_ ':t"jE [ Oupk | 0'wpk| amp| 0C
inpu e
Iﬁ ok I 0 Wave 003 Lirnit

: — o
pin[ " + [ owpk [ 0wk

I 0 YWave 0 Z Lirnit

|| ICIFFI.IHE
I—

L= L= L=
mutt:l solo | wink II close |
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Loudspeaker Views

Self-Powered Subwoofers:

Many ofthe subwoofer loudspeaker models display excursion limiting as well as limiting.

) spk09 650-P |

—saub Temperature
) | 0 %pk I 0 %wpk | amp nc )
ﬁ ok I 0 YWave I 0% Exc Excursion
= Indication
: I_ —saub Fan zpeed
"
At [ owpk [ 0wek | primam [ 0%
Im VDD I 0 YWave 0 % Limit | reserve |of £

unregulated

zLpply | |CIFFI.IHE
Las] Lalis] I

Lals]
mutt:I solo | wink II close |

Four Channel Amplifier Loudspeakers:

Four channel models display voltage output, power output and limiting percentages for an additional two
channels. They also display temperature readings for upper as well as lower amplifier sections. Inaddi-
tion, the PSW-6 displays excursion limiting for the front and rear drivers and the MSL-6 displays VHF
limiting forthe highdriver.

© ) spk11 MTS-4 |

—high Temperature Additional
inpLt [0 0vpk [ 0%k | upper 0 C4+— Temperature
[0 0wpk || 0wave| 0 %Limit| lower [ 0C Reading
pir-,l- + —mid Fan speed

IEI 0 %Wpk I 0 "pk | primary I 0z

00 0wDC || OWave | 03 Limit| reserve |of £

unregulated
supply —low
|EI.EI‘u"pk| 0 wple ..
| 0 Yave | [ % Lirnit Additional
Channels
—szLb
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| 0 Yave 0 2 Lirnit
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Lo o= e
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The Options Menu

When you select Options in the menu bar, or hold down the Alt key and press O, the Options pull-down
menuwill appear. This menu consists of the following options:

Status Bar

Background...

Muting...
Title...

Choose Status Bar from the Options menu (Options>Status Bar) to toggle the status display at the bottom of
the screen off & on.

Toggles the status bar display on & off.

Opensthe Background Settingsdialogbox. ~ Ctrl+B
Opens the Muting Settings dialog box. Ctrl+M
Opensthe Title Settings dialog box. Ctrl+T

Changing Background Settings (Ctrl+B)

Choose Background from the Options menu (Options>Background) to launch the Background Settings
dialogbox. Selectthe background color, foreground color and pattern for the panel background. A
preview of your choices will be shown inthe lower right. Use the radio buttons to choose between
patterns and use the mouse to select your desired colors. Click OK to exit and apply the changes to the
current background. Click Cancel or press the Esc key to discard changes and return.
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The Options Menu

Changing Muting Settings (Ctrl+M)
Choose Muting from the Options menu (Options>Muting) to launch the Muting Settings dialog box.

Changing the Muting options will only be effective if your RMS speakers are muting enabled. A jumper on
the amplifier communication board must be set to mute. This procedure is done at the factory but may be
done by the user. Forinformation on changing the muting jumper yourself, refer to Appendix page 1-26
ofthis User’s Guide.

2 Do not allow muting. and
unmute all speakers.

|
i Allow miing,
Cancel |
3 Dizable muting permanently
until program iz restarted.
and unmute all speakers.

= A jumper must be inztalled on the speaker's
communication board to enable muting.

To switch between Muting options, select the radio button next to the muting option you want.
1. Allow muting: Enables muting and soloing of speakers.

2. Donotallowmuting: Switching to this option will unmute all speakers and will prevent
muting and soloing until the muting optionis changed (Default).

3. Disable muting permanently: This option willunmute all speakers and prevent muting until
the program is restarted and the options are changed.

Click OKto exit and apply the muting settings. Click Cancel or press the Esc key to discard the changes
and return.

Changing Title Settings (Ctrl+T)

Choose Title from the Options menu (Options>Title) to launch the Title Settings dialog box. Select Show
Device or Show Title to choose what text is displayed at the top of the loudspeaker views. Itis useful to
display the device names when installing and configuring an RMS system. Click OKto exitand apply the
title change. Click Cancel or press the Esc key to discard the changes and return. By default, the speaker
titleis shown at the top of the loudspeaker views.

Exiting RMS (Alt F4)

To exit the RMS program, select Panel in menu bar and then select Exit, or hold down the Alt key and
press F4. If you have not saved your work a dialog box will prompt you to save. Choose Yes to save
your changes and choose No to discard any changes youmade since last saving the panel.
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RMS Quick Reference Guide

Key to Alarms and symbols

s A\
@ Service pinonthe amplifier user panel is pressed.
Warning Icon Shows ifany of the following are present:
Amp Heat Sink Temperature >70° C
Primary Fan Off or Speed is>97%
Reserve Fan On
Open Driver Circuit
Driver Short Circuit
Speaker Offline
. J
Short Cut Keys
e N
Ctrl+N Panel-New
Ctrl+O Panel-Open
Ctrl+S Panel-Save
Ctrl+A Add Page
Ctrl+D Delete Page
Ctrl+R Rename Page
TabKey  Scrollthroughpanel pages
1,2,3..0  Displaypanel page 1to 10
Ctrl+M Muting Dialog
Ctrl+B Background Dialog
Ctrl+T TitleDialog
Alt+F4 ExitRMS
. J
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Appendix

Program Notes

Tobackupyour RM Sfilesfrom hard disk tofloppy disk, backup all thefilesinthe C:\TNODE directory and subdirectories.
These directories contain the RM S database files, the RM S executable, and Panel files.

These Files can be backed up with the DOS commands COPY and XCOPY. For more information on using these commands
to backup and restore RMS files, refer to your DOS or Windows manual.

The RMS Database is initially an empty database, which is installed on the host computer when it is first configured. If these
files are copied to your hard disk at a later date, all logical installation information will be lost. The directories, groups, and
paths described below are normally setup when your computer is factory configured for RMS, and need not be changed.

All of the RMS programs and files are located on the computer’s first hard disk, assumed to be disk C:. The RMS database
consists of the files located in the directory C:\TNODE and its subdirectories. These files are used by LonMaker to create
a network configuration of installed loudspeakers and by the DDE server and the RMS executable to monitor speakers.
The DDE server, LMSRVR.EXE is located in C:\LONWORKS\LM _DDE. 1t is a Windows program that normally runs
minimized (asanicon).

The RMS executable, RMS.EXE, is located in C:\TNODE. 1t is a Windows program. When RMS.EXE is started, it
automatically starts the DDE server if it is not already running. It normally runs maximized (full screen). The LonMaker

program, LNMG.EXE, is located in C:\LNM. This program is used to install loudspeakers on the network. This isa DOS
program. When LonMaker is started, it automatically opens a DOS window. It normally runs maximized for bestresolution.

Windows Program Groups

Icons for the RM S program, |abelled “Remote Monitoring System”, are located on the desktop and in the Meyer Sound
Laboratories program folder, and the start-up program group. Theseiconsrefer to the RMS.EXE Windows executable
locatedin C:\TNODE.

ThelconfortheDDE serverislocatedintheL onManager DDE Server programgroup. Thisicon referstotheLMSRVR.EXE
Windowsexecutable(EXE) locatedin C:\LONWORKS\LM_DDE.

Iconsfor the LonMaker program, labelled “LonMaker”, are located in both the Meyer Sound Laboratory program group
and on the desktop.

If youdonotwishtostart RM Severy timeWindowsisstarted, simply deletetheRM Siconfromthestart-upgroup. Torestore
the RM Sicon to the start-up group, copy it from the Meyer Sound L aboratories program group. |cons can be copied from
group to group by holding the CTRL key and dragging theicon from one group to another. 1f no RMSicon can be found,
the Windows file manager can be used to create aprogram item (icon) from the RMS.EXE executablein C:\TNODE.

Windows Screen Resolution

The default screen resolution is 1024x768 pixels. Athigher resolutions, more icons may be placed on the screen but will be
smaller. To change the Windows screen resolution, select the Windows Setup icon, or use the program supplied by your
video card manufacturer. For more information, see your Windows documentation. A 16 bitor greater color screen is required
to take full advantage of RMS.

Panels

Panel files are stored by default in the C:\tnode directory. Panels may be saved to other directories and disks by using the
Panel|SaveAs function, and entering a new target destination.
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Appendix

The RMS.INIfile

The RMS program maintains information in the RMS.INI file located in the Windows directory. The contents of a
typical RMS.INI file is shown below.

[RMS]
LastFile=C:\TNODE\DEMO.PNL
Pattern=102

Colori=12

Color2=6

The LastFile entry contains the last panel file used by RMS. When RMS starts, it reads the RMS.INI file and loads the
last used panel automatically. The pattern and color entries are used for the background; if the panel file does not
contain this information (i.e. from an earlier version of RMS), the values in RMS.INI are used. Ifthe RMS.INI file is not
present, RMS will continue to operate normally.

Please refer to your MS-DOS and Windows documentation for information on Autoexec.bat files, paths, program
groups, program items, and .INI files.

The PCLTA board used by the RMS desktop host requires a driver to be loaded every time the computer starts up.
The config.sys, located in the root directory of the boot drive (drive C:) has an entry similar to the following:

DEVICE=C:\LONWORKS\BIN\LDVPCLTA.SYS/P340/D1/U15/150/050/
This line automatically loads the proper driver at boot up.

Note: Ifyou are using the PCLTA-10 or PCC-10 card, the above mentioned driver is not needed.

Changing the Muting Jumper

In order to enable the muting and solo functions of RMS, your RMS amplifiers must be set to muting enabled. This

involves installing the jumper you received with your RMS speaker onto the communications board.

1. Remove the AC power cord from the speaker and wait at least five minutes disassembling the speaker.

2. On the RMS board are two jumper pins labled “short to enable mute”. Install the two pin header shipped
with your RMS speaker onto these pins. Then reassemble the speaker.

MP-X Series Communications Board Detail. Ultra Series Communications Board Detail.
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RMS Configuration Data Sheet

Customer Name

Venue

Date

( Model

Speaker S/N

Amplifier S/N

Device Name

Additional Notes
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RMS™ Host Computer Reguirements List

Minimum System Requirements:

Operating System: Windows- 95/98

RAM: 32MB

Hard Disk: 10 MB available space
Floppy Drive: 1.44MB

Video Card: 1 MB VRAM - 16 hit color
CPU: Pentium Processor

Digplay: 800x600 screen resolution
Accesories. mouse pointing device

RM Sdesktop computers must have onefree half length | SA dot for the Network
Communications Board.

RMS laptop computers must have one free Type Il PCMCIA dlot.

Recommended RM S System:

Operating System: Windows™ 95/98

RAM: 64 MB
Hard Disk: 20 MB available space
Floppy Drive: 1.44MB
Video Card: 4 MB VRAM for desktop computers
2 MB VRAM for Laptop computers
CPU: 266 MHz Pentium or greater
Digplay: 1024x768 screen resol ution for Laptops or Desktops
Accesories. mouse pointing device
|4
7——Nleyer
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/fRM STM M.S.PN. 05.033.075.13 Rev. A
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RMS™ Host Computer
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[11995-2000 Meyer Sound L aboratories, Inc. Berkeley, CA

All rightsreserved. Informationinthisdocumentissubject tochangewithout notice. Nopart of thisdocument
maly bereproduced or transmittedinany formby any means, e ectronicor mechanical, for any purpose, without

theexpresswritten permissionof Meyer Sound L aboratories, Inc.



[ RMS™ Host Computer Software Installation J

Thisguideliststheall the stepsnecessary toinstall and configurethe software componentsof an RMSHost
Station. The RM Shost software runs on Windows 95/98 operating systems. Thisguide assumesthat you
have aworking Windows 95/98 computer and some experiencein setting up and troubleshootingM S-
Windows based computers.

Note: Werecommend installing RM Son adedicated computer, freefrom other applications.

For information on minimum system requirements, refer to the Meyer Sound Document “RMS™ Host
Computer RequirementsList.” (Meyer Sound Part Number 05.033.075.13 Rev A3.5)

Thisguideispart of an RMSHost Desktop or Host L aptop Computer Kit. Alsoincluded inthesekits:

Hardware Componentsfor aDesktop Kit:

1. RMSPCLTA-10with FT-10A network interfacecard Meyer Sound Part Number 950.052
2.RM S Cable (10 feet) Meyer Sound Part Number 28.033.079.01

Hardware Componentsfor aL aptop Kit:

1. RMSPCC-10 (PC Card) Meyer Sound Part Number 950.034
2.RMSPC Card Cable Meyer Sound Part Number 28.033.080.01
3.RMSCable (10 feet) Meyer Sound Part Number 28.033.079.01

Software Components:

1. Echelon LonManager DDE Server Softwar e Meyer Sound Part Number 950.029 (2 disks)

2. Echelon LonMaker Meyer Sound Part Number 950.030 (2 disks)

3. RM SProgram and Databaseinstallation disk 90.033.047.01 (1 disk)

4. Echelon LonWorksPCC-10/PCLTA-10Installation Softwarefor Windows 95/98 Meyer
Sound Part Number 90.033.047.04v2.0
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[ RMS™ Host Computer Software Installation J

InstallingtheLonWorksPCC-10/PCLTA-10Driver Software

1. Turnonthecomputer and start Windows.
2.  InsertthePCC-10/ PCLTA-10 Installation Softwaredisk intodriveA.

3. Fromthe Windows Start Button select Settings then Control Panel. Double click the Add / Remove
Programs |con and select Install and then next.

4. Thetextinthediaogbox should read* A:\setup.exe” . If not, changeit. Then press<Enter>. The
Lonworks PCC-10/ PCLTA-10 Installation program will start.

5. When prompted, select English asthe native language and then select Next.
6. Review thelicensing agreement and select Yes if you agreeto theterms presented.

7. Theinstallation programwill prompt you to chose adestination directory. Select Nextto
choosethedefault directory “C:\lonworks’. Theinstallation programwill begin copyingfiles.

8.  When prompted with“ Do youwantto add a‘PCCLON1’ and a‘PCCLONZ2’ devicein your
DOSCONFIG.SYSfilenow?” , select Yes.

9. When prompted with “ Do you want to add a DOS* virtual’ device driver which will allow you
to access the interface from DOS applications under Windows?” , select Yes.

10. Atthe Setup Completediaog select Finish. Thiswill launchthereadmefilefor thedriver. When
you arefinished reading, closethetext window by selecting File and then Exit.

11. AttheRestart Windowsdialog select “No, | want to restart my computer later” and then select OK.

Installingthe PCLTA-101SA Network I nterface Card (Desktop installationsonly)

1. Fromthe Start menu, select Shut Down . . . and shut down the computer by selecting ‘Shut down the
computer?’ and then selecting Yes.

2. Withthe PC powered down, unplug the computer from your AC outlet and removethe cover.
3. Plugthe PCLTA-10cardintoafreel SA card dot. Replacethe computer cover, plug the computer
back into your AC outlet, and reboot the system.
Installingthe PCC-10 PC Network I nterface Card (L aptop installationsonly)

1. Fromthe Start menu, select Shut Down . . . and shut down the computer by selecting ‘Shut down the
computer?’ and then selecting Yes.

2. Thecardyouareabouttoinstal isaTypell PC Cardandwill only work inaTypell compatible
dot. Consult your laptop manua for PC dot locations, typesand installationinformation.

3. Ingtall the PCC-10 PC card and reboot the system.
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[ RMS™ Host Computer Software Installation J

4.  WhenWindowsdstarts, it will automatically locatethe PCLTA-10 or PCC-10 card and install the
necessary drivers.

5. Openthecontrol panel (Start menu, Settings, Control Panel) and double click the Lonworks Plug ‘n
Play utility.

IntheDevice Selected field, verify that PCCLON1 isselected.
Inthe NI Application field, select PCC10L 7.
Verify that the systemsimage path contains c:\L onworks\images\pcltal0 or \pcclO.

© o N o

After verifying that your Lonworksdriver configurationiscorrect, select OK to exit and select
Yes to savethe configuration settings.

[ewine Geecied LonWorksPlug‘nPlay utility screenfor a

System Image Path field should contain:
C:\LONWORKS\image\pccl0
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Installing the Echelon L onM anager Dynamic Data Exchange (DDE) Ser ver
Thisconsstsof two disksfrom the Echelon Corporation labeled “ LonManager DDE Server” release 1.53
(or higher) (Meyer Sound Part Number 950.029.). Whilerunning Windows:

1. InserttheDDE server disk#1lintodriveA.

2. Openthecontrol panel (Start menu, Settings, Control Panel). Double click the Add/ Remove
Programs |con and select Install and then Next.

3. Thetextinthedialog box should read “ A:\setup.exe” . If not, changeit. Then press<Enter>. The
DDE Server Ingd lation programwill start.

4. Atthe DDE Wecomewindow select Continue to run the setup. When prompted, enter your name
and company name then select Continue to proceed.

5. AttheCustom Instalation window select Install.
6. When prompted, insert the DDE server disk #2 intodrive A: and press<Enter>.

35



[ RMS™ Host Computer Software Installation J

0.

When prompted with *Would you like to search for and update any tools, libraries, or utilities
that this product may havein common with other products’ select Yes. Theinstallation pro-
gramwill scanthehard disk.

At the Config.syswindow do not check anything and press<Enter>. Ignorethewarning*® No
driver isinstalled” and press<Enter> to continue.

At thelngtallation Complete dia og, removethefloppy disk and select Return to Windows.

Installingthe Echelon LonMaker Program
Thisconsistsof two disks from Echelon Corporation labeled “ LonManager LonM aker Softwarerel ease
2.02 (or higher)” (Meyer Sound Part Number 950.030) .

1.

From the Start Button select Programs and then Command Prompt. Thiswill bring up anMS-DOS
Window.

Insert the LonMaker disk #1 into drive A: and at the DOS prompt type a:\install then press
<Enter>. Thiswill runtheLonMaker instalation.

When prompted, pressthe<Enter> key twiceto continue, then select Drive C: asthetarget
drivefor ingtalation. Press<Enter>to continue.

When prompted with the\LNM directory, press<Enter>. Thiswill specify C:\LNM asthedirectory
wherethe LonManager will reside on your computer.

At the next menu select Install ‘Graphics PC’ executable and press<Enter>.
When prompted, insert the second LonM aker disk into drive A: and press<Enter>to continue.

When prompted with Modify Autoexec.bat?’ PressY and then press<Enter> at thefollowing
window.

When prompted with * Modify Config.sys?’ PressY and then Press<Enter> at the next screento
continue.

Press<Enter>to continue. Atthe C:\LNM prompt removethedisk fromdriveA: andrestart the
computer.

Installingthe RM SHost Program (Meyer Sound Part Number 90.033.047.01)

1.
2.

3-6

FromWindows, insert the“RM SProgram & Databasefor Windows’ ingtallation disk intodriveA: .

Openthecontrol panel (Start menu, Settings, Control Panel). Doubleclick theAdd/Remove
Programs lIcon and select Install and then Next.
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3. Thetextinthedialog box should read “ A:\setup.exe” . If not, changeit. Then press<Enter>. The
RM Singtalation programwill launch thiswel comewindow:

‘wimkoors B the Flarmobs W oy Salen St
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Syaiurmon pour comgrisi
I i shonghe rscommsnded Frat pou mat ol YWindows: peograme:
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L ni::p-mpﬂﬂldh.':m-ﬁt

IUnauthonzed reproduction o delnbubion of this progesm. o 2
penrhiry ol B, vl sl o s Sl el rirrinal el sl
wall b peramcuted o the masareum sdtend poosibls urden lee

T P

4. Select Next.

5. Theingalation programwill display the RM S softwarelicense agreement. Pleaseread and fully
understand thetermsof thelicense agreement and then select Yes if you agreeto thetermsof this
contract. You must accept thetermsof thisagreement toinstall RMS.
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Copanght 155951593 Mepei Sound Laboinione:, InCorpoiblid. Alnghls neberesd j
-

D st ot ll L D of el s i) Licsiroi S gn inraiard 7 11 haiia K, Selug
vl cloas, Tiosrplad Fsanote Monionng Spebem, you mat scoeph l'l::m
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6. Theingdlationprogramwill display thefollowing window:

T it il Pt Bl "V Pl S By i naired off e
company you vk forand the pecduc peisl

cges [ 0 | Concel |

7. Enter your name, your company, and the serial number which can befound onthePersonal License
Password Document (M.S.PN. 05.033.075.08 Rev. 3.4) included in your RM Sdocumentation
package. Carefully enter the serial number datathen select Next.
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8. TheRMSinstallation programwill ask you to select between Full Installation and Upgrade.
Warning: Selecting Full Installation will resultinthelossof &l dataentered into anexisting
RM S network database. Make sureyou select Upgrade if you are upgrading from aprevious
version of RM S and want to keep your network database.

Whenyou are sure of your choice, select that option and click Next.
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If you select Full Installation youwill receive I you select Upgrade youwill be presented with

thiswarning. ClickNext to continue. thiswindow. Click Nextto continue
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9. Atthenext window select thetype of installation: Desktop or Laptop. After making your selection

based on thetype of computer you areinstalling RM Son, select Next:

Lilect Comparenl s

(Plizgne pslet e Ippa of inplslsbon po regEs.
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10. Select the program folder whereyouwant the RM Sand LonMaker iconsinstalled. Then select
Next. We strongly recommend using the default program fol der.
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“'ond iruld DD o Tl 1ok e, od dedaict oied Fone Hhe Ssteg
Fikdaiz kil Chek Mecd 5 contimea.

Prosgraen Folders:
[zt Fordunng Gastend
Exnbrg Fokisr

£
Faliodse
Ainhs feciohal
Crropsen Indeimistions
CRT

Dol Acmpmmr

EVRSEN

Iriskall 5 edigg

I vsh St Izl roem T hestinh 2 =l

« ack Bt = Canesl |

3-10



[ RMS™ Host Computer Software Installation J

If you are performing an RM Supgrade, thefollowing Information window will appear.

ir) The FS st program sl now updass poir eaing RS cotatane. W ams e thes FIMS catalass upcats 1
- pucresshy then clops the [0S srvjos by chcking n the upper ight hend comer> of tha sandow

A DOSwindow will open and the RM Sdatabase will be upgraded.

Makse surethe RM S database updateissucessful, then closethe DOSwindow by clicking inthe
upper right hand corner of thewindow.

311



[ RMS™ Host Computer Software Installation J

11. Ifthisisafull install of RM S software, the Setup Complete window the RM Singtall ation program
will display amessageregarding the DDE server. Inorder torun RM Syou must first configure the DDE
server. Select Finish. You have now completed installation of RMS. Please proceed to the next
section of thisdocument to verify and configurethe LonMaker program and the DDE Server.

Lelup Complete

Bl st iy s i e @i, i sl eorlguns (s ODE
Gerves. aned than reglad poes compuler.

I e Tonad e Tl

Plesss rsdas In e RS Hisl Compulsy configustion
retiahoes hor b sl oimnason.

[

If thisisan upgrade of existing RM S software, the Setup Complete window theRM Singtallation
programwill display asfollows. If youwant to view the Read Mefileor start RM S, sel ect those options
before clicking Finish. You have now completed installation of RMS.

Simtup has Fnashesd s laling Rarote Mondonng Seebem on po
CoRTRadey

Situp can lsunch Fe Fieed M Rle s Al emote Hondomg
Gpsbery Chocse e apbons you vwant beios,

T~ mw Fmac W fl

™ Sis Fismole Monkodng 5 pshen

Click Fireh o coimphils 5elug.
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Check LonM aker

1. ClosetheDDE Server andthe RM S program if they are running and then doubleclick onthe
LonMaker icon located onthe desktop or intheMain program group. Thiswill launchthe
LonMaker program. When LonMaker starts, awarning message regarding conventional memory
may be shown. Pressany key to continueloading LonMaker. LonMaker will functionas
required by RMS.

Note: If youwould liketo addressthewarning message consult Appendix A of thisdocument.

2. Atthetopright of the LonManager window you should see abutton that says* Attached to
Network” . If the button reads“ Not Attached to Network” , click on the button and it should
changeto“ Attached to Network” . If it does not, check that the DDE Server isnot running and
then restart LonM aker again.

3. If your RMSHost computer hasother peripherals(i.e. soundcard, network adapter, etc.), you may
be encountering ahardware conflict between the RM Snetwork card and another device.

4. If LonMaker runs properly, select the Exiticon to exit and returnto windows. Refer tothe* Self-
Powered L oudspeaker Instalation and Wiring Guide” for moreinformation regarding operation of
theLonMaker program.

3-13



[ RMS™ Host Computer Software Installation ]

DDE Configuration

1. Fromthe Start Button select Programs and then the LonManager DDE Server folder.
2. SelecttheLonManager DDE Server Icon. At thewelcome screen click OK.
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LonManager DDE Server Folder and Icon
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3.

AttheLonManager DDE Server Configuration dia og typethefollowing into the Database directory
fidd: ‘c:\tnode\db_ingt’.

At thenetwork interface prompt enter thefollowing information.

Driver lonl (default)
Nodename  monitor (changefromIm)

L oossled gy DD E Seiveen Dol iggi almos

Dalalase
Dimghory  CVTRODEWDE_INST ]

7 Shaee oo .|

Habwork Iniedsce

Driwet Wames  [lan1 |

Hods Heme  [manido |

I Ghess

[# Make ose e delaull peilings.

LonManager DDE Server Configuration Dialog

Select thetwo boxes|abeled share inthe LonManager DDE Server Configuration window so that
they are both checked.

Select Formatting.
IntheUser TypeFilefieldtype‘c:\tnode\user.typ’.
Inthe User File Format Filefield type‘c:\tnodeluser.fmt’. Thenselect OK.

1 gt -
|[:'LLI.'IH'H'I.'IHI=2?'-.T'1'F'E SLUENNVT.TYP | Hiowse . |
Canecel |
SHVT Fommat File:
|[. ALDNWDRESATYPESASNYT FRT ] Duowse .. |
Ugea T ppe File:
|- \tnode s typ | Biowss |
i Usea Fommal File:
[[.'l-lnud-n"-u:ur.l’ml ] Diowse . . |
Format Didlog
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9. Select Tracing. Verify that the Warningsand Command options are checked and that the DDE Data
and Formatting optionsare not checked, then select OK .

Trace Options

[+ Warnings
[+ Commands Cancel |
[T DDE Data
[~ Formatting

TracingDidog

10. Select Messaging.
11. IntheNetwork Variables Only section of the window set the servicetypeto Unacknowledged then

select OK.

T -~ |
Mo Vst O
Smvice  |Unacknowledged = | Canmel |
Maizage Taga (inly Hath
[ Btz abe [~ Paiity
™ becharte Sequence Munsa
Service | Aok numdedycd =] Wumber of etsme 1|

Messaging Didog

12. Youdo not need to changeany optionsinthe Timing dialog.

Pull Bl i vl iLi]
__ Concel |

Ht-fpare il [ ametcask _-“1 |
Taress ane wpocled in bendhis of seconds.

TimingDidog
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13. Sdlect OK intheLonManager DDE Server Configuration window to save the changesyou made.
TheDDE Server will display aseriesof initiaization messages and then awel come screen. You do
not need to click OK. Thewindow will disappear shortly.

14. Select theLonMaker DDE Server Icon onyour Task Bar . Thiswill Restoretheminimized LonMan-
ager DDE Server program. Check thewindow for error messages, then close the program by
selecting File and then Exit.

Disabling Screen Savers
Althoughthisstepisnot required, it isrecommended sincemost RM Suserswill wishto havetheRM S
display activeat al times.
1.  If your computer isrunning athird party Screen Saver (e.g. After Dark) disableit. If you need help
indoing so consult the screen saver documentation.
2. If youarerunningaWindowsscreen saver disableit.
A. Fromthe Start Button select Settings, then Control Panel then Display.
B. AttheDisplay window click thetab at thetop of the screen titled Screen Saver.
C. Atthe Screen Saver dialog set the screen saver to None then click OK.
D. Closethe Display window and the Control Panel.

Restartingand RunningRM S

Restart your computer. Your computer should run RM Sautomatically on start-up. The DDE program will
display awelcome screen. You do not need to click onthe OK button asit will vanish after afew seconds.
The DDE server will runminimized asanicon. TheRM Spanel screenwill bedisplayed.

Congratulations, you arenow running RM S,
To begin monitoring speakersyou must first install each self-powered |oudspeaker onto the RM S Network.

For loudspeaker ingtallation proceduresrefer to the RM S Self-Powered L oudspeaker Installation and
Wiring Guide” document. (M SPN 05.033.075.07)
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Appendix A

Note: Beforespending agreat deal of timetrying to get rid of the memory warning that appearswhen
starting LonM aker, please be awarethat LonMaker will still function correctly if you choosetoignorethe
warning. Itwill notinterferewith theinstallation routines as described in the RM S Self-Powered L oud-
speaker Ingtalation and Wiring Guide.

If youwishtorid your computer of memory resident programs, follow the stepsbel ow:

A. Open the M S-DOSwindow by double clicking ontheMS-DOS icon.

B. Edit the config.sysand autoexec.bat filesusing the DOS editor <edit.exe>. Removeany
programsor driversnot used by RM Swhich may betakingup memory.

C. Reboot the computer so that the changesto the system filestake effect.

D. GototheLonMaker MS-DOSwindow memory properties page and set thetotal conven-
tional memory back to 600Kk.

E. Closethe properties page and double-click on the LonMaker icon to start the program.

F. Repesat steps A-F until 600k of conventional memory isfree.

Note: If you cannot, or do not want to removeany memory resident programs, and still get the
warning message thefollowing procedure shows how to add the Expanded Memory Driver
toyour system.

Thefollowing procedureisnot recommended for userswho run RM Son adedicated Host System, free
from other gpplications. Installing these driversmay decreasethe amount of available conventional memory.

If you have removed or do not want to remove memory resident programs, and you continueto receive
memory warningswhen starting LonMaker, you can load the Expanded Memory Driver and the Extended
Memory Specification that comeswith Windows. To do so, add thefollowing linesto the beginning of your
Config.sysfile

DEVICE=C:\WINDOWSHIMEM.SY S
DEVICE=C\WINDOWS EMM386.EXERAM

Thismay increasetheamount of avail able conventional memory on most systems.
If you arestill receiving memory warnings, and you want to continueto pursue asol ution, pleaserefer to

Windows 95 Help, and look in the Index under index entry ‘ memory’ and then under the subentry ‘ trouble-
shoating'.
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The RMS™ Self-Powered Loudspeaker User Panel

(2 O 1 Network
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56 & 6 O [millellle

Remote Monitor System

Every RM S enabled Self-Powered L oudspeaker contains an RM S User Panel on the back of the speaker
cabinet. The RMS User Panel has three LEDs and two buttons. Their functions are described bel ow:

Service LED -

Service Button -

Wink LED -

Reset Button -

Activity LED -

When blinking once every two seconds, the Service LED indicates that the
network hardware is operational, but the loudspeaker is not installed on the
network.

When the loudspeaker has been installed on the network the Service LED will be
unlit and the Activity LED will flash continuously..

When continuoudly lit ,the Service LED indicates that the loudspeaker has alocal
RMS hardware failure. In this case, the RM'S communication board may be dam-
aged and you should contact Meyer Sound Technical support.

Pressing the service button will display a cartoon-face icon on the corresponding
loudspeaker display icon on the RM S screen.

When thisLED islit, the Wink LED indicates that an ID signal has been sent
from the host station computer to the loudspeaker. Thisis done using the wink
button on the loudspeaker Icon, Meter or Text views in the RM S host program.

Pressing this button will reset the network module inside the loudspeaker. This
will cause a muted loudspeaker to unmute, but will not otherwise affect the
loudspeaker installation.

When the Activity LED is unlit the loudspeaker has not been installed on the

network. When the loudspeaker has been installed the Activity LED will flash
continuously.
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This guide lists the steps necessary for installing Meyer Sound Self-Powered L oudspeakers on a
RMS Network. Loudspeakers must be installed on the RM S Network before the RMS Host
program can access them. There are 3 stepsinvolved with installing a self-powered loudspeaker:

1. Definethe device— Add anew device definition to the network database.

2. Install the device— Identify the device to the network through the use of the service pin on
the RMS Self-Powered L oudspeaker User Panel.

3. Connect the device — Associate network variables between the device and the monitor pro-
gram (RMS Host program). If thisstep is skipped, RMS will access the |loudspeaker, but the
data update rate will be slowed down. The degraded data update rate will be noticeable when
ameter view is opened for aloudspeaker on aRM S Host panel.

The LonMaker Network Management program is used to Define, Install and Connect Meyer
Sound Self-Powered Loudspeakers on a RM S Network.

Sarting the LonMaker Program

1

2.

4-4

Close the RMS program and the DDE server if open.
Double click on the LonMaker icon on the desktop.

If you encounter a warning message which reads “ Not enough memory for all func-
tions.” , press <Enter> to continue. LonMaker will run fine after ignoring this warning
message. To address this memory warning, refer to Appendix A. in the Host Com-
puter Software Installation section included in your RM S documentation package.

At the LonMaker welcome window press <Enter> to continue. You will see a set of
messages, “ Initializing...” , “ Accessing network...” and “ Parts Catalog Rev. # . After
the messages compl ete, the main screen will appear.

In the upper right corner of the LonMaker window you should see a button that says:

“ Connected to Network” . This message will appear even if you have not yet installed a
loudspeaker. This message is confirmation that your computer has recognized the Ech-
elon PCLTA-10 or Echelon PCC-10 board. If the message reads “ Not Connected to
Network” , try initializing the network card again by clicking on the button. If you con-
tinue to see the message Not Connected to Network” and have aready installed the
Echelon PCLTA-10 or PCC-10 card refer to the RMS Host Computer Installation docu-
ment included in your RM S package.
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Defining Devices

1.

Power the amplifier you wish to install and connect the RM S cable from either RMS
port on the amplifier to the RM S port on your computer. Note: Multiple loudspeakers
may be connected to the network while loudspeakers are installed.

Select the Device Setup button, then select the Define button or pressF2 to launch
the Define Device window. Make sureeng is selected in the Locations window.

Enter a unique name in the Device Name field (up to eight characters). Use incremental
names (i.e. spk01, spk02, node01, node02, Subl, msl4-1, etc.). This nameis used to
identify the loudspeaker when it is added to a panel in the RMS Host program. Y ou may
choose to use a device name that indicates the location of the loudspeaker in your setup
(i.e. left0l1, rightOl1, monl, rearl, etc.).

Select the pull down menu button in the Device Type field or pressF2. Thiswill launch
awindow that will allow you to choose from alist of Device Types. Using the mouse
and or the arrow keys highlight prodéh or rms3. Loudspeakers shipped after acertain
date will contain the rms3 firmware. Double click on the selection or press <Enter>

to confirm your selection and return to the main Define Device window. Note: If the
incorrect device type for aparticular loudspeaker is selected the Install step will fail.

If this happens, use the Remove function in the Device Setup section of LonMaker to
remove the device, then redefine the loudspeaker as described above and select
another device type.

Click on the pull down menu button in the Chan Name field or press F2. Highlight
sp_channel with the mouse cursor or by using the arrow keys, then press <Enter> or double
click on the highlighted text to confirm your selection and exit this window.

At this point the main Define Device window should contain the following information.

Device Name: spk01 (or next in sequence)
Location: eng

Device Type: prod6h or rms3

Chan Name: sp_channel

Chan Priority: NO

If any of the fields are set to values different than those list above (other than the Device
Name) change them to reflect the listed values, otherwise click on the Save button or
press F6 to store the device setup information.

If you wish to install more than one loudspeaker, continue to enter device names pressing

F6 after each entry in order to save the data. When you are done adding devices, click on
the Cancel button to exit the Define Device window.
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Installing Devices

1

2.

Click on the Installation button which is located on the | ft side of the screen.

Using the mouse, highlight the name of the device you want to install.

Press F3 or click on the Install button to begin the installation.

When the computer prompts you to do so, press the service pin on the user panel of the

loudspeaker. If thereisalong aperiod of inactivity, check the RM S cable and the RM S
connections and press the pin again.

Note: All RMS self-powered loudspeakers are installed before leaving the factory. If you are

trying to install a newly defined device that already has configuration datain it you may
receive the following message “ The device you have selected already has configuration
datainit”. Click on the Continue button or press F2 to replace the configuration datain
the loudspeaker. If the device was already defined and installed in the database you will
receive the following error message: “ the Device ‘name’ isalready installed” . In this
case use the Repair function in the Control section of LonMaker to replace the device data.
See* Replacing a RMS Powered Loudspeaker” section later in this guide.

When prompted with “ Installation Successful” press F10 or click on Done. You may wish
to write the device name on alabel and apply it to the back of the loudspeaker.

Creating Connections

1
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Highlight the device name of the most recently installed loudspeaker (i.e. spk01), then
press F8 or click on the Connect button to launch the Connect window.

Click on monitor in the devices window. Thiswill bring up a new button at the bottom of
the screen titled Auto.

Press F3 or click the Auto button. A plus (+) will appear next to the word monitor
as confirmation.

Press F10 or click on Done to create the new connection.

A * creating connections’ message will appear. When the loudspeaker is connected the
message will disappear.

Repeat steps 1-5 for each loudspeaker installed.
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Checking the Amp Type and Testing the L oudspeaker

1.

Click on the Control button on the left side of the screen then press F9 or click on the
Data button in the lower right of your screen.

In the lower of the two windows on your screen is aline which contains information
about the nciAmptype network variable. Identify thisline and highlight it by clicking on
it with the mouse. The value for nciAmptypeis set in each speaker before they leave
the factory and you should not have to change it. The value for the nciAmptype should
be set to 2 for 2-channel amplifiers and 4 for 4-channel amplifiers. The defaultis2. The
only 4-channel amplifiers, at the time of publication, are in the MTS-4, the MSL-6, and
the PSW-6 self-powered loudspeakers. To modify the nciAmptype press F2 or select the
Modify button. Thiswill launch awindow which will allow you to set the proper value.

After setting nciAmptype, highlight one of the following fields in the upper window:

nvol5 Highlight thislineif you have installed atwo channel amp.
nvo24 Highlight thislineif you have installed afour channel amp.

Verify that the computer is receiving data from the amplifier by pressing F7 or clicking
on the Info button. Thiswill launch awindow titled Raw Data Info. Watch the Hex Data
field. The numbersin the far left of thisfield will increment if the loudspeaker is prop-
erly installed and connected.

When you have verified that the amp is sending data to the computer press F10 or click
on the Done button.

Select the Wink function by using the mouse or pressing F5. The Wink LED on your
amplifier user panel will light momentarily. If you misstheindication, select the wink
function again.

Keep alist of the serial numbers, loudspeaker types, and device names of al of the
loudspeakers you install. You will need to refer to it later, when you add the speakersto a
panel in the RMS Host program. You may want to label the back of the speaker cabinet
with the device name.

If you want to install more speakers, return to the Defining Devices section on page 3-5.
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Exiting LonM aker

1

2.

Select the Exit button in the lower left corner of the screen.

PressF10 or click the Exit button to confirm.

Replacing a RM S Self-Powered L oudspeaker
If you are replacing an RM S self-powered loudspeaker and wish to use a previously installed device,
follow these steps.

1

2.

Disconnect the damaged loudspeaker from the network and connect the new loudspeaker.
Start the LonMaker program and then select Repair.

Highlight the name of the device you wish to replace and then select Replace. When
prompted, press the service pin on the new loudspeaker.

Exit LonMaker when the process is compl ete.

Un-installing a Self-Powered L oudspeaker .
To remove the logical installation from the firmware of an RMS amplifier because of a node
conflict follow these steps:

1

2
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Press the service pin on the loudspeaker user panel and hold it in.

Press and release the reset pin on the loudspeaker while continuing to hold the service
pinin.

Continue to hold the service pin until the activity LED stops blinking.
Release the service pin.

The loudspeaker activity LED will turn off and the service LED will blink every
two seconds indicating that the loudspeaker is now uninstalled.
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Whileit is possible to wire an RM S system in a near-infinite number of ways, an individual net-
work using Free Topology (flexible wiring configuration) can only address 62 L oudspeaker nodes
over a maximum cable length of 500 meters (1640 feet) using 22 AWG cable and a single bus
terminator. A terminator is asimple resistive capacitive device designed to prevent network
reflections. Using a double terminator topology with 22 AWG cable allows a maximum cable
length of 1400 meters (4593 feet). Using 16 AWG cable and a double terminator will allow a
maximum cable length of 2700 meters (8858 feet).

If you want to connect more than 62 loudspeakers you will need a network repeater. A network
repeater increases the capacity of datatraffic through an RM S network.

To increase the cable length you will need a network repeater. A network repeater increases the
signal strength for long distances.

Pictured below are several proven wiring topologies. For information on wiring large systems
please contact Meyer Sound.

|
Network Terminator

Single Termination Bus Topology
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Network Terminator

Star Topology

Mixed Topology

Network Terminator




[ RMS™ Network Specifications )

Maximum L oudspeaker Nodes:
Standard system-62;
With network repeater-125 (please contact factory for further information).

Cable Type:
16 AWG, : Belden 85102, 8471 (or equivalent) twisted pair, stranded, unshielded
22 AWG*,: Belden 8442 (or equivalent) twisted pair, stranded, unshielded

Maximum Network length without installation of repeater(s):

Free Topology, 22 AWG or 16 AWG cable, one 52.3 Q type terminator:500 m (1640ft)

Bus Topology, 16 AWG cable, two 105Q type terminators. 2700m (8858ft)
Bus Topology, 22 AWG cable, two 105Q type terminators. 1400m (4593 ft)

M aximum Node-to-Node Distance:

Free Topology, 22 AWG cable: 400m (1312ft)
Free Topology, 16 AWG cable: (Belden 85102 or equivalent): 500m (1640ft)
Free Topology, 16 AWG cable (Belden 8471 or equivalent): 400m (1312ft)

Termination:
Free Topology (£500m (1640ft)):one 52.3 Q type terminator at any point
Bus Topology (3500m (1640ft):two 105 Q type terminators (one on either end)

Connector Type: 2-wire Plug with recommended snap-on lock

Network Platform: Differential Manchester Encoding; Polarity Insensitive, Variable Topol ogy
Transceiver: EMI: complies with FCC Part 15, Class A; UL recognized; VDE: EMI compliant
Data Rate: Standard System: 78Kb/s; Larger systems. contact factory

*Meyer Sound strongly recommends using 20 AWG cable (Belden 8205 or equivalent) for more robust
mechanical network terminations. However, the minimum required cable for proper network operation
is22 AWG (Belden 8442 or equivalent).

4-11



Loudspeaker Installation

Remote Monitor

Server (CPU) Host

To Loudspeaker

To CPU

1.00"
r 25mm SERVER (CPU) HOST
+ No Locking Blocks are used
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SPEAKER TERMINATION WITH
LOOP OUTPUT FOR SPEAKER
TO SPEAKER CONNECTION
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Introduction

This document is distributed with the Meyer Sound
Remote Monitoring System Network Repeater Kit
(PN.40.033.084.01). Thisuser’s guide will illustrate
how to incorporate the FTR-100 Network Repeater
into your RMS Network topology. The FTR-100
Repeater is required if any of the following conditions
are present:

Your RMS Network exceeds 62 speakers
(maximum of 124).

Your total network cable length exceeds
500 meters using a free-topology.

Your total network cable length exceeds
1400 meters using a doubly-terminated bus
topology.

Please insert this documentation in the Additional Docu-
ments section of your RMS binder.

You should receive the following parts in the Network
Kit:
1. AC Adapter, 12VDC 1 Amp power
supply Meyer Sound Part Number
574.007.
2. RMS FTR-100 Network Repeater
Meyer Sound Part Number 950.045
3. 2.5m Cordset Meyer Sound Part
Number 538.012
4. Power Cord Meyer Sound Part Number
538.009

What is a repeater?

A repeater is a network device that connects multiple
segments of a network cable, re-times and regener-
ates the digital signals on the cable, and sends them on
their way again. A repeater forwards all digital mes-
sage signals in both directions, regardless of the desti-
nation or domain of the message.

The actions of a repeater allow you to increase the
geographical coverage of your network. The FTR-
100 has the capability of increasing your total RMS
Network cable length by a factor of four.

The repeater also allows for an increased number of
loudspeaker “nodes” on a RMS Network. As de-
scribed previously, the FTR-100 regenerates the RMS
Network message. This regeneration allows for a
more robust network-messaging construct, thus allow-
ing more nodes on a single network.




7——Meyer

Sound

i RMS”

FTR-100 Network Repeater
Operating Instructions

P/N:05.033.075.12
DATE: 11.1.00
REV: A

Document Title: Operating Instructions for the FTR-100 Network Repeater.

Operational Description

The FTR is a four-channel network repeater. A mes-
sage generated on any network segment to which the
FTR is connected is rebroadcast on the three other
channels.

The following figure shows the physical specifications
and the front panel:

FTR-100 REPEATER

4 Z%Z Z%Z
oz g Pl g 37
o O O |[ocooo] © o) o)
Installation

Mechanical Installation

The FTR can be mounted on a wall or other
surface using four #6 wood screws (or equivalent). It
can be mounted horizontally with the terminal blocks
facing down, or vertically with the terminal blocks on
the right side. The FTR unit and associated wiring
should be mounted and fastened securely, so that no
stress is incurred. Do not install the FTR in a manner
that would allow unanticipated disconnection.

There are six status LEDs on the unit:

- The PWR LED is the power indicator. Itis
ON if power is properly supplied to the
unit

- The other five LEDs give an indication of
the amount of network traffic. The TX1-4
LED flashes whenever a message is trans
mitted by the repeater. The RX1,RX2,
RX3, RX4 LEDs flash whenever a mes-
sage is received on a particular channel.

For example, if a message is received on channel 1,
the RX1 LED would flash, the message would be
transmitted on the other channels (2, 3 and 4), and the
TX1-4 LED would flash.

Network Terminations

The FTR is capable of providing network termination
if desired (consult the Logical Installation and Wiring
Guide section of the RMS binder). As shipped, each
channel on the FTR has 51 Ohm network termination
resistors connected. This is the standard network ter-
mination required for the network. If no termination
or 100 Ohm network terminations is required, the top
must be removed and shorting jumpers reconfigured
as shown follwing.
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Network termination can be changed by moving the
shorting jumper on CN1, CN2, CN3, or CN4. The
following figure and table describe the jumper posi-
tions:

TB3

Wiring

The FTR is wired using five position terminal blocks.
The wiring pin-out for the FTR module is shown
below.

D19 TB1 D20 D21 TB2 D22 D25 D24
O O Pin Description Functionality
1[0J0 O] 1[0[C Q] 1[C[C O] 1[0[c O] .. .
CN1 CN2 CN3 CN4 PWR A+ Power A+ positive supply connection
PWR A- Power A- negative supply connection
N/C No connection (Reserved)
O O PWR B+ Power B+ positive supply connection
PWR B- Power B- negative supply connection
NET1 Nework channel 1 connection
Channel | No. Termination | 5Q Termination 100Q Termination NET1 Nework channel 1 connection
Channel 1 | CN4 No Jumper [ CN4-jump 1and 2| CN4-jump 2 and 3 N/C No connection (Reserved)
Channel 2 [ CN3 No Jumper | CN3-jump 1and 2|  CN3-jump 2 and 3 NET2 Nework channel 2 connection
Channel 3 | CN2 No Jumper | CN2-jump L and 2|  CN2-jump 2 and 3 M= Nework channel 2 connection
- ! NET3 Nework channel 3 connection
Channel 4 [ CN1 No Jumper | CN1-jump 1 and 2| CN21-jump 2 and 3
NET3 Nework channel 3 connection
N/C No connection (Reserved)
NET4 Nework channel 4 connection
NET4 Nework channel 4 connection
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Power A+ and Power A- are the power supply in-
puts. Connect the positive lead of the power supply
to the terminal block Power A+ and the negative lead
of'the power supply to the terminal block Power A-.

If'a redundant supply is required, connect it to
Power B+ and Power B-. Connect the positive lead
of'the redundant power supply to the terminal block
Power B+ and the negative lead of the power
supply to the terminal block Power B-.

Network 1-4 are the network connections. Network
1 is the channel 1 network connection. Connect the
first network twisted pair to the terminal block NET1
positions. The wiring is polarity-independent so it does
not matter which wire in the pair is connected to which
position on the terminal block. Connect the rest of the
network twisted pairs to the other channels. Leave
any unused channels unconnected.

Universal Power Supply

The universal power supply included in the repeater
kit allows for FTR operation around the world. The
supply accepts any input voltage from 100 to 240VAC,
and produces the required 12VDC output. The male
IEC input allows for any locale-specific adapter to be
used with the supply.
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RMS Integration

The following diagram depicts a recommended RMS
Network setup using the FTR repeater:

FTR Repeater

[T o

o mmmﬁ ‘l

Control Room / Mix Position ‘

The total length of each NET cannot exceed 500 meters
using this free topology form. The FTR Repeater should
be kept close to the RMS Host Station, in a contained
environment free from possibilities of disconnection.
In any case, the length of NET1 cannot exceed 500
meters.

More elaborate setups are possible, of course. When
designing an RMS network, please review all of the
available RMS literature on wiring, termination, and
functionality. If in doubt, verify a design before incor-
porating it into a fixed installation.
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Appendix

FTR-100 Specifications

Power Supply +12VDC to +24VDC +/- 10% @ 100mA

Data Communications Differential Manchester Coding

Network Polarity Polarity Insensitive

Transmission Speed 78 kilobits per second

EMI Complies with FCC Part 15 Class A

Operating Temperature

-40°C to +60°C

Storage Temperature

-40°C to +85°C

Operating Humidity

25% to 90% @ 50°C non-condensing

Storage Humidity

0% to 95% @ 50°C non-condensing

Approximate Dimensions

245mm L x 634mm H x 143mm W (9.65" X
2.50" x 5.65")

Approximate Weight

11b. (625 g.)

Packaging

Aluminum enclosure

Documentation Reference

- RMS User’s Guide - The Connectors/ Terminator section of

(05.033.075.01) the RMS binder
- Self-Powered Loudspeaker Installation (Drawings 28.033.060 and
and Wiring Guide 40.033.061)

(05.033.075.07)
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